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Preface

This document provides general information about the DECevent NT 4.1 software. This 
document also describes the restrictions for this release of DECevent NT.

Intended Audience

This document is intended to assist anyone who uses DECevent NT to translate, analyze, 
display event logs, or generate reports.

Documentation Conventions

The following conventions are used in this guide:

Related Documents

For more information about this software, refer to the DECevent NT 4.1 User Guide.

User Entries Information that should be entered exactly as it appears in 
the document is shown in bold.

Variables Information that will vary depending on your computer or 
user profile is shown in italics.

System Output Responses from the system are shown in a monospaced 
font.
Rev.1/31/00–A
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Further Information
Further Information

For more information about DECevent NT, refer to the Compaq web site at the following 
URL:

http://www.support.compaq.com/svctools 

Select the “Download the Tools” link. From the download page you can access the DECevent 
NT page which contains the latest kits and documentation.
Rev.1/31/00–A
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Release Information

This chapter provides information about the functionality and features of DECevent NT.

1.1 Supported Products List

The following platforms are supported by DECevent NT Analysis and Bit to Text translation:

• Compaq AlphaServer GS60 6/525 Bit To Text and Analysis

• Compaq AlphaServer GS140 6/525 Bit To Text and Analysis

• AlphaServer 8200/8400 6/525

• AlphaServer 8x00 6/525

• AlphaServer 8200/8400 5/300/350/400/625

• AlphaServer 8200/8400 CRD

• AlphaServer 4xxx 5/xxx

• AlphaServer 1200 5/xxx

• Digital Server 7300

• Digital Server 5300

• Additional Devices — see Section1.3.1 for details

1.2 Features and Capabilities

The features and capabilities of DECevent NT are described in the following sections.

1.2.1 Error Logging for AlphaServer Platforms

Support is available separately to DECevent NT and the error logging service that enabl
operating system to log errors on these platforms. DECevent NT provides analysis and 
Text output for those entries. To make use of this facility, new console code and HAL are 
required.
Rev.1/31/00–A
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1.3 New Features
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1.2.2 Capability to Read Event Files Saved by Microsoft 
Event Viewer

DECevent NT can read files saved by Event Viewer in .evt format.

Note

The default file format for event files is .dnt, which is not readable.

1.2.3 Automatic Analysis and Notification Manager

Automatic Analysis translates data from an event log into usable segments of information. All 
entries received in the event log are immediately sent for analysis. The event log is then 
monitored for a specified time period and DECevent NT tracks the number of identical events 
that occur. When the number of entries exceeds the predetermined threshold, the events are 
displayed as a potential problem.

Automatic Notification allows you to establish notification venues that report error logs, 
suggested repair information, registry information, and previous repair history. You can set up 
one of the following notification methods:

• Electronic mail notification to engineers and users

• A system-initiated call logging system (SICL) that transfers the information to the 
Customer Service Center (CSC)

• A web-based self-help system that provides suggestions on how to fix a particular f
that is detected in the system

You can find more detailed information about the Automatic Analysis and Notification 
Manager in the DECevent NT User Guide.

1.3 New Features

The following subsections list the new features for DECevent NT V4.1.

1.3.1 Enhanced BTT Translation of SCSI Storage 
Devices

DECevent NT decodes I/O events that are logged by the SCSI port, Miniport, and Class
drivers. These events are translated like any other events. 
Rev.1/31/00–A
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Release Information
1.3 New Features
DECevent NT can decode the following common drivers:

1.3.2 Turbolaser Double Error Halt BTT Analysis

Turbolaser Double Error Halt Bit-To-Text translation is now supported. This includes the 
AlphaServer 8xxx, the GS140, and the GS60.

1.3.3 Storage Header Support

The SWCC storage header Bit-To-Text translation is now provided.

1.3.4 RA3000 (Anaconda) BTT Translation

RA3000 (HSZ22/Anaconda) Bit-To-Text translation is now supported. This device is 
supported via utilization of the SWCC storage header.

1.3.5 DSGGA Brocade Switch BTT 

DSGGA (Brocade Switch) Bit-To-Text translation is now supported.

• 4mmdat
• Aha174x
• Aic78xx
• Cdrom
• Cpq32fs2
• Cpqfcalm
• Dac960nt

• Disk
• Dlt Tape
• Dlt
• Deckzpsx
• Hszdisk
• Lp6nds35
• Miniport

• QI10wnt
• Scsidisk
• Scsiport
• Symc8xx
• Symc810
Rev.1/31/00–A
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1.3 New Features
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2
Installation and Uninstallation

This chapter describes the installation and uninstallation procedures for DECevent NT. 
System requirements and Automatic Analysis are also discussed. 

Note

The PC-based DECevent NT kit only supports the view capability and does not 
support analysis.

2.1 System Requirements

Before installing DECevent NT, make sure that your system meets the following 
requirements.

Hardware

• 20 MB disk space

• 16 MB random access memory (RAM)

• VGA or better monitor

• 2X CD ROM (unless you download the kit from the internet)

Software

• Microsoft Windows NT 4.0 or later

• DSNlink (optional, see the DECevent NT User Guide for more information)

• Internet access (unless you install the kit from the CD)
Rev.1/31/00–A
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2.2 Pre-Installation Procedures
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2.2 Pre-Installation Procedures

You must have the proper version of the following components to take full advantage of the 
error logging facility. 

• The SRM console code

• The AlphaBIOS console code

• The HAL (the kit also includes the PAL code)

• The error logging driver and service (which are considered a single component)

AlphaServer 4x00/1200, Compaq DS5300, and Compaq DS7300 Platforms

In order to use DECevent NT on these platforms, the system must meet the following 
requirements:

• SRM 5.3

• AlphaBIOS version 5.68 

• NT 4.0 HAL OEM Revision E, which includes PAL V2.2 or NT 5.0 HAL. 

2.2.1 Determining the Current HAL Version

To determine the current HAL version for Windows NT 4.0, use the following procedure:

1. Open Windows NT Explorer.

2. Select the Find File or Folder option from the Tools pull-down menu.

3. Type HAL.DLL in the dialog box and select your system drive (usually D:).

4. When HAL.DLL is found, right click on it and select Properties from the menu.

5. Select the Version tab to see the file version.

2.2.2 Upgrades

The error logging driver and service can be found in the latest HAL kits or in the system O
kits for the 8x00 platforms. For the most recent SRM and AlphaBIOS console firmware and 
HAL kits, refer to the General Alpha Firmware web page at the following URL:

http://www.compaq.com/support/files/AlphaNT/firmware 

If you are installing DECevent NT on a system for the first time, you must install the driv
and service prior to installing DECevent NT in order to enable the logging of events.
Rev.1/31/00–A
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2.3 Installing DECevent NT
2.3 Installing DECevent NT

The following sections detail the procedures for installing DECevent NT. Before begining the 
installation process, close all open applications.

Note

Before you install the current version of DECevent NT, you must remove all previous 
versions of DECevent NT that are on your system. Also, if Automatic Analysis is 
running in the background as a result of a previous installation, you must remove it 
before proceeding. See “Uninstalling Automatic Analysis” on page 6 for more 
information.

2.3.1 Installing DECevent NT from a CD-ROM

The Readme file, available on the CD, has version specific information about DECevent NT. 

To install DECevent NT, run the installation program for Alpha or Intel, depending on your 
platform. From the Windows | Decevent | Kits | Winnt directory, select either the Alpha or the 
Intel directory and run the application contained in the directory.

DECevent NT uses an installation wizard that guides you through the installation process.

Installing Automatic Analysis

You can choose to have the setup program install Automatic Analysis for you, or you can 
install Automatic Analysis later. See “Installing Automatic Analysis” on page 2–5 for more 
information.

Using the CD-ROM’s Links (optional)

Note

Some CD-ROMs may not accommodate this feature. If the CD-ROM is equipped 
with links, be sure that you have a web browser up and running. Also verify that the 
Service Tools CD is equipped with DECevent NT V4.1 before installing.

1. Locate and select the WINDOWSNT.HTM file from the Navigation folder on the Service 
Tools CD. The WINDOWSNT.HTM file opens in your browser.
Rev.1/31/00–A
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Note

You may see a prompt that indicates that your system cannot find the file. This should 
not interfere with your ability to install via the internet. Click OK to proceed.

2. From the WINDOWSNT.HTM page, click on the link for DECevent. Locate the 
appropriate executable for your system. 
If you would like to read more about DECevent NT before you install the program, the 
documentation is available from this location.

3. When you select the appropriate executable file, you will need to select the location 
where you want to save the DECevent NT installation files. 

When you are ready to install DECevent NT, you can run the installation from your local 
machine using the saved copy of the application file.

2.3.2 Installing DECevent NT from the Internet

Follow these steps to install DECevent NT from the Internet:

1. Use your browser to access the following URL:

http://www.support.compaq.com/svctools 

2. Select the “Download the Tools” link.

3. From the tools page, select the “DECevent” link.

4. In the “downloadables” section, select the link for the kit that corresponds with your
platform.

5. Additional hardware information is provided at the top of the page including links fo
downloading firmware upgrades, if your firmware does not meet the minimum 
requirements. The installation files are located at the bottom of the page.

6. You can either install the files directly from the web or download them to your PC fo
later installation.

• If you download DECevent NT directly from the internet, the installation wiza
is launched to guide you through the installation.

• If you choose to save the DECevent NT files to your hard drive before beginn
the installation, specify the directory where the files should be saved. When 
are ready to install the application, select the application file from the directo
you specified. The installation wizard launches.
Rev.1/31/00–A
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2.4 Installing Automatic Analysis
2.4 Installing Automatic Analysis

If Automatic Analysis was not installed by the installation wizard, you can install it using the 
Control Panel or through DECevent NT.

Installing from the Control Panel

To install Automatic Analysis from the Control Panel, use the following procedure:

1. Select Settings | Control Panel from the Start menu.

2. In the Control Panel window, double-click on the Analysis and Notification Manager 
icon.

Note

You will not see the icon unless DECevent NT has already been installed. You must 
install DECevent NT before you can activate Automatic Analysis.

3. In the Service Control area, select Install.

Installing from DECevent NT

1. Start DECevent NT.

2. Select Auto Analysis & Notification from the Options menu.
The Automatic Analysis and Notification dialogue box is opened.

3. Choose Install to begin the installation.

2.5 Running DECevent NT

Use the following procedures to start and stop DECevent NT. For more information about 
operating DECevent NT, see the DECevent NT User Guide.

Starting DECevent NT

Select Programs | Administrative Tools (Common) | DECevent NT from the Start menu.

When DECevent NT launches, the Event Log window is displayed.

Stopping DECevent NT

To end your DECevent NT session, either choose Exit from the main File Menu, or close the 
window.
Rev.1/31/00–A
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2.6 Running Automatic Analysis
2.6 Running Automatic Analysis

Use the following procedures to start and stop Automatic Analysis. For more detailed 
information on Automatic Analysis and Notification, see the DECevent NT User Guide.

2.6.1 Starting Automatic Analysis

Open the Automatic Analysis dialogue box by selecting Auto Analysis & Notification from 
the Options menu and then choose Start from the dialog box.

2.6.2 Stopping Automatic Analysis

To stop Automatic Analysis, select Cancel from the Automatic Analysis and Notification 
dialogue window, or close the window.

2.7 Uninstalling DECevent NT

Follow these steps to uninstall DECevent NT:

1. Stop Automatic Analysis, if it is running.

2. Select Programs | Administrative Tools (Common) | Uninstall DECevent NT from the 
Start menu.

2.8 Uninstalling Automatic Analysis

To uninstall Automatic Analysis, select Uninstall from the Automatic Analysis and 
Notification Manager window. Once this procedure completes, the Current Status will indicate 
the service is not installed.
Rev.1/31/00–A
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Restrictions

This chapter describes the restrictions for DECevent NT.

3.1 Linking and Embedding DECevent NT in OLE 
Containers

Inserting DECevent NT objects into OLE containers is not supported at this time.

3.2 Context Specific Help

Context sensitive help is not implemented in this release of DECevent NT. However, it is 
supported in the control panel applet for Automatic Analysis and Notification.

3.3 Events Not Added to DECevent NT Display As 
They Occur

This release does not support dynamic addition of events as they occur to event logs that are 
currently opened. To see new events, open a new event log, and connect to the event log again.

3.4 SICL Notification File

In order to use SICL notification, the following file must be present:

c:\temp\LastSI CLMsg.txt

SICL will operate even if the file is empty.
Rev.1/31/00–A
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3.5 File Extension
3.5 File Extension

If you want DECevent NT to correctly read files created by the Windows NT Event Viewer, 
make sure that the files have a .log extension. If the extension is .evt, only half of the 
events are read.

3.6 Using the deceventcli Command

Files opened with the deceventcli command remain open after processing is completed 
and must be closed with the following command:

Decevent>/f=t.t 

Where t.t is a dummy file.
Rev.1/31/00–A
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